Legal Notices

This Documentation, which includes embedded help systems and electronically distributed materials (hereinafter referred to as the “Documentation”), is for your informational purposes only and is subject to change or withdrawal by erwin Inc. at any time. This Documentation is proprietary information of erwin Inc. and may not be copied, transferred, reproduced, disclosed, modified or duplicated, in whole or in part, without the prior written consent of erwin Inc.

If you are a licensed user of the software product(s) addressed in the Documentation, you may print or otherwise make available a reasonable number of copies of the Documentation for internal use by you and your employees in connection with that software, provided that all erwin Inc. copyright notices and legends are affixed to each reproduced copy.

The right to print or otherwise make available copies of the Documentation is limited to the period during which the applicable license for such software remains in full force and effect. Should the license terminate for any reason, it is your responsibility to certify in writing to erwin Inc. that all copies and partial copies of the Documentation have been returned to erwin Inc. or destroyed.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, ERWIN INC. PROVIDES THIS DOCUMENTATION “AS IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT WILL ERWIN INC. BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT, FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF ERWIN INC. IS EXPRESSLY ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE.

The use of any software product referenced in the Documentation is governed by the applicable license agreement and such license agreement is not modified in any way by the terms of this notice.

The manufacturer of this Documentation is erwin Inc.

Provided with “Restricted Rights.” Use, duplication or disclosure by the United States Government is subject to the restrictions set forth in FAR Sections 12.212, 52.227-14, and 52.227-19 (c)(1) - (2) and DFARS Section 252.227-7014(b)(3), as applicable, or their successors.

Copyright © 2020 erwin Inc. All rights reserved. All trademarks, trade names, service marks, and logos referenced herein belong to their respective companies.
Contact erwin

Understanding your Support
Review support maintenance programs and offerings.

Registering for Support
Access the erwin support site and click Sign in to register for product support.

Accessing Technical Support
For your convenience, erwin provides easy access to "One Stop" support for all editions of erwin Data Modeler, and includes the following:

- Online and telephone contact information for technical assistance and customer services
- Information about user communities and forums
- Product and documentation downloads
- erwin Support policies and guidelines
- Other helpful resources appropriate for your product

For information about other erwin products, visit http://erwin.com/products.

Provide Feedback
If you have comments or questions, or feedback about erwin product documentation, you can send a message to techpubs@erwin.com.

erwin Data Modeler News and Events
Visit www.erwin.com to get up-to-date news, announcements, and events. View video demos and read up on customer success stories and articles by industry experts.
## Contents

**Legal Notices** .................................................................................................................. 2

**Contents** ............................................................................................................................. 4

**Working with erwin Data Modeler Navigator Edition** .......................................................... 9

Intended Audience .................................................................................................................... 10

erwin Data Modeler Navigator Edition .................................................................................... 11

Modeling Overview ................................................................................................................... 12

The Application Development Cycle ...................................................................................... 13

**Installation** .......................................................................................................................... 14

Install erwin Data Modeler Navigator Edition ........................................................................ 15

Uninstall the Navigator Edition .............................................................................................. 16

Post-Installation ....................................................................................................................... 17

Install the SSL Certificate ....................................................................................................... 18

**Navigating Data Models** ..................................................................................................... 19

Data Models ............................................................................................................................. 20

**Basic Data Modeling Concepts** .......................................................................................... 21

Model Types ............................................................................................................................ 22

Entities ..................................................................................................................................... 23

Tables ....................................................................................................................................... 24

Types of Entities/Tables .......................................................................................................... 25

Attributes and Columns ........................................................................................................... 26

Primary Key and Non-Keys ....................................................................................................... 28

Relationships ............................................................................................................................ 29
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Types of Relationships</td>
<td>30</td>
</tr>
<tr>
<td>Other Relationship Types</td>
<td>32</td>
</tr>
<tr>
<td>Foreign Key</td>
<td>34</td>
</tr>
<tr>
<td>Workplace Panes</td>
<td>35</td>
</tr>
<tr>
<td>Overview of Model Explorer</td>
<td>37</td>
</tr>
<tr>
<td>Model View</td>
<td>39</td>
</tr>
<tr>
<td>Subject Area View</td>
<td>40</td>
</tr>
<tr>
<td>The Model Explorer Toolbar</td>
<td>42</td>
</tr>
<tr>
<td>The erwin Toolbox</td>
<td>43</td>
</tr>
<tr>
<td>Alignment Toolbar</td>
<td>44</td>
</tr>
<tr>
<td>Drawing Toolbar</td>
<td>45</td>
</tr>
<tr>
<td>The Go to Diagram Option</td>
<td>46</td>
</tr>
<tr>
<td>Object Properties</td>
<td>47</td>
</tr>
<tr>
<td>Object Moving, Copying, and Deleting</td>
<td>48</td>
</tr>
<tr>
<td>Action Log</td>
<td>49</td>
</tr>
<tr>
<td>Action Log Panes</td>
<td>50</td>
</tr>
<tr>
<td>Details Pane</td>
<td>51</td>
</tr>
<tr>
<td>Summary Pane</td>
<td>52</td>
</tr>
<tr>
<td>Action Log Tasks</td>
<td>53</td>
</tr>
<tr>
<td>Locate Text Using the Find Feature</td>
<td>54</td>
</tr>
<tr>
<td>Use Extended Find and Filter</td>
<td>56</td>
</tr>
<tr>
<td>Undo a Transaction</td>
<td>57</td>
</tr>
<tr>
<td>Redo a Transaction</td>
<td>58</td>
</tr>
</tbody>
</table>
Reverse a Transaction ................................................................. 59
Undo and Redo to Selected Transaction ........................................ 60
Undo/Reverse Comparison .......................................................... 61
Generate a Session Activity Report ............................................... 62
Advisories Pane .......................................................................... 63
Overview Pane ........................................................................... 64
Bulk Editor Pane ........................................................................ 65
Open an Existing Model ................................................................ 66
Open a Model Saved in XML Format (XML Import) ...................... 67
Connect to Mart .......................................................................... 68
Open a Model from the Mart ......................................................... 72
Customizing the Appearance of Data Models .............................. 74
Display Levels ........................................................................... 75
  Logical Display Levels .............................................................. 76
  Physical Display Levels ............................................................ 78
Display Options .......................................................................... 80
  Entity or Table Display Options ................................................ 81
  Relationship Display Option ...................................................... 82
Font and Color Change for Individual Objects ............................ 83
  Customize Object Fonts and Colors .......................................... 84
Changing the Diagram Window Magnification Level .................... 85
Print a Data Model ..................................................................... 86
Print Only What You Want .......................................................... 88
Working with erwin Data Modeler Navigator Edition

This section contains the following topics

Intended Audience
erwin Data Modeler Navigator Edition
Modeling Overview
The Application Development Cycle
Intended Audience

This guide is intended for use by individuals such as business or system analysts, database designers, and programmers who require read-only access to models created in erwin Data Modeler. You can use erwin Data Modeler Navigator Edition to view, print, and manipulate models. The only limitation is that you cannot save any type of model change, including any made to models accessed in a mart database. You can use this product on data models that are on a local drive, network drive, or in a mart database to:

- View the work of others while it is in progress.
- Provide input without inadvertently changing work.
- Read the information in a model in order to create queries, reports, or applications.

If you are already familiar with erwin Data Modeler, erwin Data Modeler Navigator Edition offers most of the features currently available in the full-feature version of these products.

**Note:** For more information about product differences, see [erwin Data Modeler Navigator Edition Differences](#).

To use this product with data models, you should have a working knowledge of database management, entity-relationship diagrams, and IDEF1X and IE data modeling terms. If you are using a data warehousing environment, you should also have a working knowledge of dimensional modeling terms.
**erwin Data Modeler Navigator Edition**

erwin Data Modeler Navigator Edition is one of the editions of erwin Data Modeler. These editions provide a foundation for building, deploying, and managing applications. These editions consist of project management, change and configuration management, modeling and design, and knowledge publication and visualization. They strengthen your ability to automate critical application life cycle processes and to thrive in the increasing complexity and rate of change in today’s business climate. They help you simplify the complex aspects of analyzing, designing, and implementing applications by providing a visualization of the relationships between business and technology. The key editions that provide the integration of design and data models are:

- **erwin Data Modeler Standard Edition**—The essential tool for data modeling.
- **erwin Data Modeler Workgroup Edition**—Supports concurrent team modeling for large client/server development projects.
Modeling Overview

Modeling is one of the most effective techniques for understanding and communicating business rules and processes. Just as an architect creates a blue print before building a structure, a database designer creates a data model before building a database. A data model is a graphical representation of a database that is used to capture an organization's business rules, which can then be used to define a system's requirements.

Typically, throughout the design process, a model is presented to business users and other members of the enterprise for review and input. As a reviewer of a data model, you may be required to provide input to the design team.

This product is a read-only version of the erwin Data Modeler database modeling tool when you are working with data models. You can use it to create, open, manipulate, print, and report on any data model. This product maintains most of the functionality of the full-feature version, but you cannot use it to save a data model or to forward or reverse engineer a database.

You can also use erwin Data Modeler Navigator Edition to open models saved in a shared database that was created using erwin Data Modeler Workgroup Edition. If you want to be able to access a mart database, contact your mart administrator. The administrator must create a mart database on a supported DBMS and a security profile for each user. Your PC must have the appropriate DBMS client connection software before you can access models in a mart database, and you must have the appropriate security permissions. See the erwin Data Modeler Workgroup Edition Administration Guide for more information.
The Application Development Cycle

To create a data model, first the business rules are gathered and the logical constructs are created. Next, the physical design is created, and then a database is implemented. erwin DM supports this iterative process by supporting multiple platforms, reuse of objects, and synchronization of changes between data models.
Installation

This section contains the following topics

Install erwin Data Modeler Navigator Edition
Post-Installation
Install the SSL Certificate
Install erwin Data Modeler Navigator Edition

The Installation Wizard makes it easy for you to install, change, or remove the software.

To install erwin Model Navigator:

1. Double-click the file you downloaded from the online erwin product page.
   The Installation Wizard opens.

2. Follow the prompts in the wizard to proceed.
   A License Agreement opens for you to review.

3. Select the option to accept the terms as described in the License Agreement. Click Next.
   The wizard asks a series of questions you must answer, including:
   - Customer Information
   - Destination folder
   - License Code

4. On the Custom Setup Type screen, review the program features that will be installed.
   You can also evaluate the space needed to install each feature.
   Click Next to continue and then click Install to start the installation.
   The program files are copied.
Uninstall the Navigator Edition

There is a known issue with uninstalling the Navigator Edition.

**Symptom:**

Suppose that you have installed erwin Data Modeler and the Navigator Edition on the same computer, through separate installations. For example, suppose that you have installed erwin Data Modeler using the erwin Data Modeler r9.2.0 installation wizard and you have installed the Navigator Edition using the erwin Model Navigator installation wizard. When you uninstall the Navigator Edition, the following messages appear:

Error 1905 Module C:\Program Files(x86)\erwin\Navigator r9\EAL.dll failed to unregister. HRESULT-2147220472. Contact your support personnel.

Error 1905 Module C:\Program Files(x86)\erwin\Navigator r9\ERXML.dll failed to unregister. HRESULT-2147220472. Contact your support personnel.

**Solution:**

Reregister the ERXML.dll and EAL.dll files manually in erwin Data Modeler again.

**Note:** To avoid this problem, install erwin Model Navigator and erwin Data Modeler from the same installation wizard. That is, select the erwin Model Navigator r9.2.0 component in the erwin Data Modeler r9.2.0 installation wizard.
Post-Installation

Before you can view models in a mart database, you need to connect to the mart database on which the models reside. The connection is made by clicking Mart, Connection on the File menu. The following must be performed before you can connect to a mart database:

- The client connectivity software for your host DBMS must be installed on the client workstation so that you can connect to the DBMS on which the mart database resides.

- The mart administrator must give you permission to access the mart database.
Install the SSL Certificate

If you have enabled SSL for the Mart, install the SSL certificate. Install the certificate on the computer from which you plan to use the Navigator Edition with erwin Data Modeler.

Follow these steps:

1. Open a web browser and go to https://servername:18170:MartAdmin.
   The server name is the hostname of the server where the Mart is SSL enabled.
2. Click Certificate Error in the Address bar and then click View Certificate.
3. Click Install Certificate in the Certificate window.
4. Install the certificate under the Trusted Root Certification Authorities certificate store.

You can now connect to an SSL-enabled Mart from the erwin Data Modeler Navigator Edition.
Navigating Data Models

This section contains the following topics

- Data Models
- Basic Data Modeling Concepts
- Workplace Panes
- Open an Existing Model
- Open a Model Saved in XML Format (XML Import)
- Connect to Mart
- Open a Model from the Mart
- Customizing the Appearance of Data Models
- Print a Data Model
Data Models

The erwin Data Modeler Navigator Edition contains the tools you need to open, view, manipulate, print, and report on erwin Data Modeler (erwin DM) data models.

Although the Toolbox and other features are enabled, you cannot save the changes you make to a data model. This product only maintains the changes that you make to a data model until you close the model. If you need to save your changes, you can upgrade to the full-feature edition.
Basic Data Modeling Concepts

Before creating or working with data models, there are some basic data modeling concepts that you must be familiar with. These concepts include:

- Model Types
- Entities
- Tables
- Attributes and Columns
- Primary Key
- Relationships
- Foreign Key
Model Types

Multiple model types allow data modelers or data analysts to work with the models best suited for their needs. The following model types are available:

**Logical**

A conceptual model that contains objects such as entities, attributes, and key groups.

**Physical**

A database-specific model that contains objects such as tables, columns, and data types.

**Logical/Physical**

A single model that includes both the logical and physical models.
Entities

An *entity* is a logical object that represents a person, place, or thing about which an organization maintains information.

In the following diagram, the logical data model has the following entities:

- CUSTOMER
- EMPLOYEE
- MOVIE
- MOVIE COPY
- MOVIE RENTAL RECORD
- PAYMENT
- STORE
**Tables**

In the logical model, an entity usually corresponds to a table in the physical model. In the physical model, a graphic box represents a table in which data is stored in the database.
**Types of Entities/Tables**

Two types of entities/tables can be drawn in a data model:

**Independent Entity**

An entity whose instances can be uniquely identified without determining its relationship to another entity. It is represented as a box with square corners.

**Dependent Entity**

An entity whose instances cannot be uniquely identified without determining its relationship to another entity or entities. It is represented as a box with rounded corners.

When you add an entity, the entity type is determined based on the relationship in which it is involved. For example, when you initially place an entity in a model, it is represented as an independent entity. When you connect the entity to another entity using a relationship, it is determined if the entity is independent or dependent based on the relationship type.
Attributes and Columns

After you have discovered the people, places, and events that define the entities in your model, you can begin to define the attributes for each entity.

Attributes collect information about an entity and columns collect information about a table. Logical attributes usually correspond to physical columns in a table.

For example, after you create the CUSTOMER entity, you can begin to define the individual pieces of information you want to track for each customer, including Name, Address, and Phone Number. In the logical model, each of these pieces of information is saved as an attribute of the CUSTOMER entity. In the physical model, attributes equate to columns in a table.

Note: A row of data is inserted in a table when a record is added to the database directly or through an application.

After you create an entity or table, you can add attributes and columns, respectively.

Many easy methods for creating and modifying the properties of these objects are provided. The most basic method is to add the name directly in the Diagram Window. You can also use a domain to add attributes and columns.
Primary Key and Non-Keys

Entities and tables are drawn as a box with a horizontal line near the top of the box. The area above the horizontal line is known as the key area because that is where the entity's primary key resides. The primary key can be comprised of one or more attributes that uniquely identify the entity.

The area below the horizontal line is known as the non-key area because that is where all other attributes reside.

Note: A foreign key may appear in either the primary key or the non-key area of an entity or table. For more information about foreign keys, see Foreign Key.
Relationships

An important object in a data model is the *relationship*, which is represented by the solid or dashed line that connects two entities or two tables. A relationship line connects a parent and a child entity or table. Usually, a symbol appears at the child-end of the relationship line. The symbol changes based on the diagram notation that you select.
Types of Relationships

Relationships are important because the type of relationship determines how a primary key of the parent entity or table migrates to the child entity or table as a foreign key. There are two basic types of relationships:

Identifying Relationship

An identifying relationship is represented by a solid line and through it the primary key of the parent migrates to the primary key area of the child entity or table.

Non-Identifying Relationship

A non-identifying relationship is represented by a dashed line and through it the primary key of the parent migrates to the non-key area of the child entity or table.

In an identifying relationship, the foreign key migrates above the line and becomes part of the primary key of the child entity (see Foreign Key for more information). In a non-identifying relationship, the foreign key migrates below the line and becomes a non-key attribute in the child entity. A dashed line represents a non-identifying relationship.
Note: If you want a non-key to migrate instead of the primary key, you can use the alternate key migration option. For more information, see the online help.
Other Relationship Types

In addition to identifying and non-identifying relationships, you can also create these relationships:

- Identifying relationship
  ![Identifying relationship diagram](image)

- Non-identifying relationship
  ![Non-identifying relationship diagram](image)

- Recursive relationship
  ![Recursive relationship diagram](image)

- Many-to-many relationship
  ![Many-to-many relationship diagram](image)
Supertype/Subtype relationship
**Foreign Key**

When you create a relationship between entities, the primary key attributes of the parent entity are automatically migrated to the child entity. The designator (FK) indicates the name of the migrated key attribute, also known as a foreign key. This migration occurs automatically in the physical model.

If the foreign key attribute has the same name as an owned attribute in the child entity, the two instances are automatically unified into one attribute because it assumes that they are the same attribute. The process of combining or unifying identical attributes in an entity is called unification.

**Note:** The foreign keys display in the model by default, designated by (FK). If you do not see this designation, open the Diagram Editor (click Diagrams in the Diagram menu), and do the following depending on whether you are working in a logical or physical model:

**Logical model**
Click the Entity tab, and ensure the options Display Logical Foreign Key (FK) Designator and Display Migrated Attributes are selected.

**Physical model**
Click the Table tab, and ensure the option Display Physical Foreign Key (FK) Designator is selected.
**Workplace Panes**

Each of the following panes within the workplace is dockable and floatable, and where applicable, contains its own toolbar:

- Explorer Pane (Model Explorer)
- Action Log Pane
- Advisories Pane
- Overview Pane
- Bulk Editor Pane

Each pane provides two options for how it displays:

- **Auto Hide**
  
  Activates auto hide. The pane becomes a tab in the application. When auto hide is activated, the pane is not visible in the workplace unless you hover your mouse over the tab of the hidden pane. When you do this, the pane is temporarily restored to allow you to work in the pane. When your mouse leaves the pane, it becomes auto-hidden once again. To turn off auto hide, mouse over the tab to restore the pane, and then click the pushpin.

- **Close**
  
  Closes the pane. To open the pane again, select the appropriate pane on the View, Windows menu.

Pane grouping functionality is provided to assist you with arranging panes in the workplace. Dockable panes can dock to other dockable panes so that they combine to create multiple tabs in a single dockable pane, or pane group. Similarly, tabs on dockable panes can be undocked / ungrouped and floated or docked to the top level frame window as individual dockable panes. When two or more panes are docked together in a tab group, the tab selection interface displays at the bottom. When panes are not grouped, the tab selection interface is not shown. When tabs are grouped, the title bar on top of the pane changes to the title bar of the currently active tab.
To dock panes together into a pane group, simply drag and drop one pane over another. To undock, drag the tab of the pane you want to undock and drop it in the workplace.
Overview of Model Explorer

The Model Explorer provides an organized, hierarchical, text-based view of your data model and its contents. It provides an easy method for creating objects. The Model Explorer lets you create, display, navigate, and modify your model.

The Model Explorer has two panes, Model and Subject Area, as shown in the following illustration:

All the objects in your model are listed in the Model Explorer, but display differently based on the active pane.
- The Model pane includes every object in your model including subject areas and domains. The Model pane is the default view.

- The Subject Areas pane displays model objects that are sorted by subject area.

When you change an object in the Model Explorer, the graphical view of the model is immediately updated with the same change. For example, if you rename a table in the Model Explorer, the new table name appears in the Diagram Window and the relevant editors. Similarly, if you change an object the diagram or in an editor, you immediately see the change in the Model Explorer.

Just as you can create an entity, a table, or a relationship using the Toolbox, you can create an object in the Model Explorer. To create an object, right-click on any object and click New. You can drag some objects from the Model Explorer onto the Diagram Window to create an object. For example, you can drag a domain onto an attribute or a column.

Using the Model Explorer, you can open the property editor for an object in two ways:

- Right-click the object and click Properties.
- Select the object and click the Property Editor icon in the Model Explorer toolbar.

**Note:** For bulk editing of object properties, you can use the Bulk Editor.

The Model Explorer and the data model are always in sync, regardless of the method you choose to add or edit an object.

You can also move, copy, and delete most objects in the Model Explorer, same as you do in a Diagram window.

After you move, copy, or delete an object, all the instances in the model that reference the object are automatically updated.
Model View

The primary purpose of the Model view is model exploration and to function as an alternative launching point for object and property editors. The Model view lists all the object types that appear in the current data model. The object types that are displayed here are based on the model type and the target server.

For example, if the model type is Logical, the Model Explorer does not include physical objects such as a view. Similarly, if the model type is Physical, the Model Explorer does not include logical objects. If the target server is Oracle, then objects specific to Oracle such as Clusters are displayed.

The following types of objects are not displayed in the Model Explorer:

- Minor objects that are included in the parent object editor. For example, a Valid Value object is created, deleted, and edited by the Validation Rule Editor.
- An object that represents configuration information, created for an internal process, and is not actual model data. For example, as a Complete Compare Option Set.
Subject Area View

The Subject Area view provides a filtered view of the model and minimizes unnecessary tree information. This view displays the model objects that are sorted by Subject Area. You can create Subject Areas to divide the model into smaller manageable parts, which is helpful when you work with large models.

The following illustration shows the Subject Area view:

Select a Subject Area to view the objects that are included in it. For example, in the previous illustration you see that the tables are categorized as tables, and views are categorized as views. This view is different from the display of the Subject Area objects in the Model view. Only those relationships are included here that are visible on the diagram and have both the endpoints present in the Subject Area.
Note: The global objects that do not relate to the selected Subject Area, such as Subject Area objects or model source objects are not displayed.
The Model Explorer Toolbar

The Model Explorer contains a toolbar to help you navigate your object editing, launch property editors, delete objects, and invoke online help.
**The erwin Toolbox**

The toolbox is the primary set of tools for drawing and editing a data model. In the Toolbox, use the Select tool to move objects and resize entity and table boxes. The cursor changes shape for each task so that you know what action is performed.

![Toolbox](image)

You have the option to resize any box to meet your presentation requirements. For example, you may want all of the entity, table, or view boxes to be uniform in size, or emphasize one or two boxes by making them larger than the others.

The toolbox changes based on the model type (logical or physical) and the notation (IDEF1X, IE, or DM).

For more information about the IDEF1X, IE, and DM notation, see the online help.
Alignment Toolbar

The appearance of your data model is important to you and the others who use it. There are many features that help you enhance the appearance of your model. You may already be familiar with some of the automatic layout features that help you arrange objects in your diagram.

A toolbar is provided that can help you quickly align the object boxes along the top, bottom, or sides of the boxes.

The tools on the Alignment Toolbar help you quickly arrange model objects.

You can select multiple diagram objects, and space them to your preference.
**Drawing Toolbar**

You can enhance a model using the Drawing toolbar to create different drawing objects. The tools work like many other popular point-and-click drawing applications. Just click a tool, click in the diagram window, and drag the mouse until the object is the right size.
The Go to Diagram Option

When you have several hundreds of objects in a model, it might be difficult to locate a specific object. To locate an object in a diagram quickly, right-click the object in the Model Explorer and click Go To Diagram. The object is selected in the Diagram window.
Object Properties

Using the Model Explorer, you can open the property editor for an object two ways:

- Right-click the object and click Properties.
- Select the object and click the Property Editor icon in the Model Explorer toolbar.

**Note:** For bulk editing of object properties, you can use the Bulk Editor.

Regardless of the method you choose to add or edit an object or its properties, the Model Explorer and the data model are always in sync.

**Note:** Object properties also migrate through relationship lines. In other words, objects can inherit properties from their parent objects.
**Object Moving, Copying, and Deleting**

Just as you can move, copy, and delete attributes and columns in the Diagram Window, you can also move, copy, and delete most objects in the Model Explorer.

After you move, copy, or delete an object, all the instances in the model that reference that object are automatically updated.
Action Log

The Action Log works in real time so you can make modeling decisions during your current session rather than having to wait until you save the model to review changes. The Action Log lets you determine the best way to work.

Note: If the Action Log pane does not display in the workplace, click Action Log Pane on the View, Windows menu.

As you work on the graphical view of a model in the Diagram Window, you can view the transaction information in the Action Log. As you make changes to your model, the Action Log is updated in real time. For example, if you create an entity in your model, the Action Log reflects this change.

Changes are only viewable in the Action Log during your current modeling session. Each new session begins with an empty Action Log. When you close the model, the Action Log clears. Before closing your model, you can generate a report that lets you view all the changes made during the current session.

The type of objects that appear in the Action Log is based on the display mode you are using. If you are working with a logical model, then only logical objects appear. If you are working with a physical model, then only physical objects appear.

The Action Log lets you search for every transaction and filter by type of change so that you can easily find a specific transaction or a set of transactions. This feature is particularly helpful when working with large models.
**Action Log Panes**

The Action Log has two panes, Details and Summary, with corresponding tabs. Select the Details tab to see every change (*transaction*) made to a model, or select the Summary tab to see the net result of changes made to a model.

**Note:** A *transaction* is a single unit of work that is not divisible into smaller components. The Action Log lets you navigate through the transaction tree using the Details pane or the Summary pane.
Details Pane

The Details pane shows all the changes you make to a model during the current session. The Details pane is the default view when you launch the program. Changes appear in the Details pane with the most recent transaction at the top of the tree, and the first transaction at the bottom of the tree. You can either expand or collapse each transaction.

The toolbar on the Details pane lets you reverse a transaction, find a transaction, view property details, and undo and redo to a selected transaction while working in the current session.
Summary Pane

The Summary pane displays the net result of changes made to the model during the current session. It provides a filtered view of all the actions you perform on the model during the current session so that unnecessary tree information is minimized, which is especially helpful when you are working with large models.

The Session Summary node is the top-level node in the tree. All changes you make to the model at the object level and property level appear below the Session Summary node in the tree.

The Summary pane is similar to the Details pane except for the following differences:

- While the top-level nodes in the Details pane are transactions, the Summary pane has only one top-level node with changes appearing below it.

- The Extended Find and Filter feature is only available in the Summary pane.

- The Reverse, Undo to Selected Transaction, and Redo to Selected Transaction options are not available in the Summary pane.
Action Log Tasks

In addition to viewing the detail and summary transactions, the Action Log provides a range of useful features that help you easily perform the following actions:

- Locate text within a transaction, object, or property using the Find feature.
- Use the Extended Find and Filter feature to locate, filter, and report on the results of your search. This feature is available only in the Summary pane.
- View old and new details relating to a property transaction using the Property Details feature.
- Reverse a transaction. This feature is available only in the Details pane.
- Undo a group of sequential transactions. This feature is available only in the Details pane.
- Redo a group of sequential transactions. This feature is available only in the Details pane.
Locate Text Using the Find Feature

The Action Log Find dialog lets you search for specific text at the transaction level, object level, or property level. This option is available on both the Details and Summary panes.

By default, the search includes the entire tree, starting from the current selection point. If there is no current selection point, then the top of the tree is used as the starting point. If the search did not start at the top node, the search wraps to the beginning of the tree after reaching the end.

**To locate text using the Find feature**

1. Click Find on the Action Log toolbar.
   
   The Find dialog opens.

2. Enter the text you want to search for in the Find what text box.

3. (Optional) Select the Transaction, Object, or Property check box to narrow your search.
   
   **Note:** Since there are no transaction nodes in the Summary pane, the Transaction search option is not applicable to that pane.

4. (Optional) Select one of the following check boxes to refine your search:
   
   **Match case**
   
   Specifies to search on case-sensitive text.

   **Match whole word**
   
   Specifies to search for the entire text string.
**Search up**

Specifies to search for the text from the bottom up.

5. Click Find Next.
   The next occurrence of text displays.

6. Click Cancel when you are finished searching.
   The Find dialog closes.
Use Extended Find and Filter

The Extended Find and Filter feature lets you set find and filter criteria and view property changes. This feature is available only on the Summary pane of the Action Log. To open the Extended Find and Filter dialog, click the Extended Find/Filter button on Action Log toolbar. When the Extended Find and Filter dialog opens, it provides a snapshot of the Summary pane and lets you filter the information that displays so you can easily find the information you want.

To use the Extended Find and Filter option

1. Click Extended Find and Filter on the Action Log toolbar in the Summary pane.
   The Extended Find and Filter dialog opens.

2. Click Find on the toolbar.
   The Find Criteria dialog opens.

3. Select the Properties, Categories, and Classes that you want to find. These options let you filter the information that displays.

4. Click Find to start the search.
   The Find Criteria dialog closes.

5. Click the Find Next button on the Extended Find and Filter toolbar to find the next occurrence of the search item.

6. Click Close.
   The Extended Find and Filter dialog closes.
Undo a Transaction

To undo the last change that you made to your model, use the Undo button on the Toolbar or click Undo on the Edit menu. This feature undoes one change at a time, and is reflected in the Action Log by a dimmed transaction.
**Redo a Transaction**

To redo a transaction that you made to your model, use the Redo button on the Toolbar or click Redo on the Edit menu. This feature restores one change at a time.
Reverse a Transaction

The Reverse feature in the Action Log lets you perform an opposite action on most entries that appear during the current modeling session. When you reverse a transaction, the model reflects the changes made to the Action Log. This feature is only available on the Details pane, and does not sequentially reverse actions.

For example, if the Details pane displays Created [Entity] object:'Entity_5'(id=5) and you select the transaction and click Reverse, a Delete on Entity_5 is implied.

Depending on how complex your model is, when using the Reverse feature, an attempt is made to restore the model to its best state. Use the Activity Log to determine whether your transaction has been properly reversed.

**Important!** Reverse applies to the entire transaction even if you select only the object or property level node.

To reverse a transaction

1. Click the Details tab in the Action Log.
2. Select a node in the tree containing an action that you want to reverse, and click Reverse on the Action Log toolbar.

   The opposite action occurs.

   **Note:** You cannot perform a reverse action on the topmost node in the tree. Use the Undo feature instead. You also cannot reverse the transaction in which the model was created - this transaction is marked with the pin icon.
**Undo and Redo to Selected Transaction**

The Undo to Selected Transaction feature in the Action Log lets you undo an entire range, or a sequential group, of transactions at the same time. Conversely, the Redo to Selected Transaction feature lets you restore a sequential group of transactions.

**Note:** To undo to a selected transaction or redo to a selected transaction, you must be in the Details pane in the Action Log.

As you create transactions on your model, each one moves the previous transaction down the tree in the Action Log, with the first transaction always appearing at the bottom of the tree. When you want to undo a range of consecutive transactions, the transactions above, including the one you select are undone. To redo a range of transactions, the transactions below, including the one you select are redone.

**Important!** After performing an undo to selected transaction, you will not be able to redo these transactions once you perform a new action, since the new action clears the redo stack.
**Undo/Reverse Comparison**

You can undo or reverse changes you make to your model. The following table summarizes the differences between the three available features, and suggests when it is appropriate to use each one:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Toolbar</th>
<th>When to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Standard toolbar</td>
<td>When you want to undo the last, single action you took. This feature is similar to the Microsoft Windows undo feature; it lets you undo the last action taken.</td>
</tr>
<tr>
<td>Reverse</td>
<td>Action Log toolbar</td>
<td>When you want to perform an opposite action that is not the last action you took in the current modeling session. This feature applies to the entire transaction even if you select only the object or property level node. You can use the Undo button to undo a reverse action made in error. For some transactions, you can also reverse a reverse action. Note that you cannot perform a sequential reverse using this feature.</td>
</tr>
<tr>
<td>Undo to selected transaction/ Undo to this point</td>
<td>Action Log toolbar</td>
<td>When you want to undo sequential transactions performed in the current modeling session. This feature lets you undo a range, or sequential grouping, of transactions at one time. You can perform a redo to selected transaction to the same group of transactions or a smaller set of the consecutive transactions in the group. You can use this feature at any time during the current modeling session.</td>
</tr>
</tbody>
</table>
Generate a Session Activity Report

You can generate a Session Activity report to view a list of objects created and deleted, and objects and properties that were changed.

To generate a Session Activity report

1. Click Pinned Reports, Session Activity.rpt on the Tools menu.
   The report is generated and opens in the erwin Report Viewer.
2. (Optional) Export or print the report.
3. Click Exit on the File menu to close erwin Report Viewer and return to the diagram.
**Advisories Pane**

The Advisories pane is a dockable, floatable window in the main workplace. This pane automatically appears when you start the program.

![Advisories Pane Image]

The Advisories pane displays messages associated with actions you perform when working with your model. Each message on this pane shows you when a change or edit you make to a property is valid and alerts you when the action you have taken violates a modeling rule. When alerted, you can immediately correct your action instead of searching for the transaction at some later time.

In addition to viewing the valid and violation messages, you can obtain details about a specific action that generated the message. For example, if you set a property, the Advisories pane shows a “Set Property” message. Click the Details button on the Advisories toolbar to display the Advisories Details dialog and get more information about the property. This feature is particularly useful when you are working with a large model and you need clarification about that particular action.
Overview Pane

The Overview pane provides a smaller, targeted view of the current diagram in the workplace and changes dynamically as you make changes to the current diagram. You can also use the Overview pane to change the view of the current diagram in the workplace by adjusting the overview area or zooming in or out.
**Bulk Editor Pane**

The Bulk Editor is provided so you can edit a small set of properties over a large number of objects. Changes and updates are immediately committed as you make them, field by field.

The Bulk Editor includes a Bulk Editor Wizard for specifying the data to edit and saving those selections as option sets for use with the model in a future editing session, or shared by all models. Because the Bulk Editor is empty the first time you invoke it in a session, the Bulk Editor Wizard is automatically opened so you can make your object and property type selections. Thereafter, the Bulk Editor is displayed as a modeless grid on a tab page on the erwin Data Modeler main window that shows your selected object instances as rows and your selected properties as columns. You can resize, rearrange, or float the Bulk Editor within the erwin Data Modeler application. Objects are identified by a fully qualified name in the *Name* column, which is non-editable. A read-only *Type* column is next to the *Name* column that displays the object type. You can click the button on the Bulk Editor toolbar at any time to open the Bulk Editor Wizard to change the object instances and properties that appear in the Bulk Editor.

![Bulk Editor screenshot](image)

During a session, opening the Bulk Editor or the Bulk Editor Wizard displays the same settings and data as the last time it was shown. These settings are stored independently for each model. This is necessary since different models can have different DBMS targets and contents, so selections of object types, properties, and object instances can be different across models. The configuration settings are stored in the registry, so each user retains their own Bulk Editor settings.
Open an Existing Model

Open an existing model to perform data modeling activities.

To open an existing model

1. Click Open on the File menu.
   The Open File dialog opens.
2. Select the drive, folder, and model that you want to open and click Open.
   The model opens.
Open a Model Saved in XML Format (XML Import)

You can use XML format to import a model file previously saved in XML format. XML format replaces the text-based ERX format used in earlier versions of this product. XML format provides structured markup of model metadata according to elements that are defined in the XML Schema.

To import a file in XML format

1. Click Open on the File menu.
   
   The Open File dialog opens.

2. Select XML Files (*.xml) from the Files of type dropdown, select the directory and XML file name that you want to open, and click Open.
   
   The File Open dialog opens.

3. Select to validate the XML file against the schema prior to opening the file.
   
   The file is verified. You can view the progress of the XML Import in the progress dialog.

Note: Any errors that occur during the XML Import process are displayed in the Advisories Pane.
Connect to Mart

If you are using erwin Data Modeler Workgroup Edition, you connect to the Mart to access models and perform administrative functions.

The way erwin Data Modeler connects to the Mart has been redesigned now. In the previous versions, erwin Data Modeler would connect to the Mart (database) server directly. Now, erwin Data Modeler connects to the Mart through a web server. You can connect multiple instances of erwin DM to the Mart from your computer.

Note: From erwin Data Modeler (DM) and erwin Mart Server (MS) 2019R1 onward, while connecting to the erwin MS from erwin DM, version validation has been implemented as follows:

1. Connecting from erwin DM 2019R1 to erwin MS lower than 2019R1 is not allowed.
2. Connecting from erwin DM lower than 2019R1 to erwin MS 2019R1 is not allowed.

At the time of logging on to Mart, you must provide the details about the web server and the Mart.

Follow these steps:

1. Click 🔄 on the toolbar, or on the ribbon, click **Mart > Connect**.
   The Connect to Mart dialog opens.
2. Complete the following fields:

   **Server Name**
   Defines the name of the web server where you have installed the Mart.

   **Port**
   Specifies the port number to access the web server.
   **Default:** 18170

   **Use IIS**
   Specifies that you want to use the IIS web server to connect to Mart. This check
box is enabled only if you have configured IIS. For more information about configuring IIS, see the Implementation Guide (Workgroup Edition).

**IIS Port**

Specify the IIS port number that you want to use. This field is enabled only if you select the Use IIS check box. The default is 80.

**Use SSL**

Specifies that you want to connect to the Mart through a secured connection. SSL lets you access the Mart through a secured connection. This check box is enabled only if you have configured SSL on your web server. For more information about configuring SSL, see the Implementation Guide (Workgroup Edition).

**Application Name**

Defines the application name of the Mart that you want to connect to.

**Default:** MartServer

**Authentication**

Specifies the type of authentication you want to use. You can use a user name that is authenticated either by the Mart Server application or by Windows.

**User Name**

Defines the name of the user that has access to the Mart. If you are using a Windows-authenticated user name, enter it in the `<domain name>/<user name>` format.

**Note:** A local Windows user who does not belong to a domain or who is not part of an Active Directory cannot log in to the Mart as a Windows user.

**Password**

Defines the password of the user.

**Note:** A password should fulfill the following criteria:
- Contains at least 1 lowercase character
- Contains at least 1 uppercase character
- Contains at least 1 number
- Is minimum 6 characters in length
- Is maximum 130 characters in length

Apart from the above criteria, special characters are optional.

Also, if you enter an incorrect password five consecutive times, your account will be locked for five minutes (300 seconds) by default.

You can change the time for which the account stays locked as follows:

1. From Windows Start menu, click All Programs, erwin, Mart Server 2020 R1(32-bit or 64-bit), Configure MartServer.
   
   The erwin Mart Configuration dialog appears.

2. On the Mart Administrator tab, edit the value of the Account Lockout Duration (Seconds) field to an appropriate value. At the most, you can set it to 30 days (2592000 seconds).

3. Click Connect.

   If you have selected Use SSL and the security certificate is installed, you are connected to the Mart.

   **Note:** After you connect to the Mart, if you click Connect to Model Manager again, a dialog opens seeking your permission to disconnect from the Mart.

   If your security certificate is not installed, the message The certificate authority is invalid or incorrect appears. You must install the security certificate to proceed.

   a. Click OK on the message.
      
      The SSL Certificate Install dialog appears.

   b. Click Install.
      
      The Certificate dialog appears.
c. Click Install Certificate.
   The Certificate Import Wizard dialog appears.

d. Click Next.

e. Click the Place all certificates in the following store option button and click Browse.

f. In the Select Certificate Store dialog, select Trusted Root Certification Authorities and click OK.

g. Click Finish.
   The security certificate is installed and you are connected to the Mart.
Open a Model from the Mart

You can select the lock option when you open a model. Model locking helps to secure models and manage how changes are saved to the mart. However, the options available to you depend upon your security profile and whether another user has already locked the model. Contact your administrator if you must change your security profile.

When you lock a model, you also have the option to retain the lock after you end your session. For example, you can retain the model lock when you work on a model offline to prevent other users from saving changes to the model.

To open a model from the mart

1. Click Mart, Open on the File menu.

   The Open dialog opens. The lock icons in the Open dialog indicate the lock status of a model.
   - A yellow open lock indicates a model is open by any user.
   - A closed green lock indicates a model is locked by you.
   - A closed red lock indicates a model is locked by another user.

2. Select a Library from the list of libraries in the left pane, a Model Name in the right pane, and one of the following locking options for the model:

   Unlocked

   You can open a model in Unlocked mode if you have permission to update and save a model. This option lets several users open and edit the same model. Users can save their changes to the master model in the mart on a first-come, first-served basis. As a result, you may have to reconcile any differences with the changes when you save the model to the mart.

   Locked

   If you have permission to update and save a model, you can select the Locked option. The model is locked exclusively for your own use and other users can not save changes to the master copy in the mart.
Read-only

You can open a model in Read-only mode if you do not have permission to update and save a model or if someone has the model opened in locked mode. When you select this option, you can only view the model and save it locally as a .erwin file (erwin Data Modeler). You cannot save your model changes back to the mart.

3. Click Open.

The model opens in a separate model window.
Customizing the Appearance of Data Models

There are many features that you can use to change the way a model displays on the screen and how it appears when you print it. For example, three different notations are supported: ICAM Definition Method 1 Extended (IDEF1X), Information Engineering (IE), and Dimensional notation (DM). To change the notation, choose Model, Model Properties, Notation on the toolbar.

You can also change the level of information that displays. For example, in the logical model, you can choose to display entity names only or the entity names, attribute names, and the key group designators. Similarly, in the physical model, you can display or hide properties such as column or datatype.
Display Levels

Two sets of display levels are provided, one for the logical model and one for the physical model.

These display levels are useful for showing different types of information in a data model, particularly when different people and groups use the data model for their specific job in the development process.
Logical Display Levels

The Logical Display levels are as follows:

Entity
Displays the name of each entity in a data model inside an entity box. No other information displays for the entity.

Attribute
Displays the attributes for each entity in a data model, with the primary key attributes above the line and the non-key attributes below the line in an entity box.

Primary Key
Displays the primary key attributes (those found above the line in an entity box) for each entity in a data model. The attributes below the line are hidden, but display when you switch back to the Attribute Display Level and you can also see them in the Attribute Editor.

Keys
Displays primary key attributes above the line and does not display any non-key attributes below the line in an entity box. Entity boxes have two attribute boxes; the upper populated with the PK attributes and the lower populated with the attributes belonging to all key types except PK.

Definition
Displays the definition for each entity in a data model.

Icon
Displays the bitmap, if you have assigned one to the entity. You can assign a different bitmap to each entity in the Icon tab of the Entity Editor.

The following diagram uses the same entities and illustrates each of the logical display levels:
Physical Display Levels
The Physical Display levels are as follows:

Table
Displays the name of each table in a data model inside a box. No other information displays for the table.

Column
Displays the columns for each table in a data model, with the primary key columns above the line and the non-key columns below the line in a box.

Primary Key
Displays the primary key columns (those found above the line in a table box) for each table in a data model. The columns below the line are hidden, but display when you switch back to the Column Display Level and you can also see them in the Table Column Editor.

Keys
Displays primary key columns above the line and does not display any non-key columns below the line in a table box. Table boxes have two column boxes; the upper populated with the PK columns and the lower populated with the columns belonging to all key types except PK.

Comment
Displays the comment for each table in a data model.

Icon
Displays the bitmap, if you have assigned one to the table. You can assign a different bitmap to each entity in the Icon tab of the Table Editor.

Physical Order
Displays the order in which each column appears in the corresponding table.

The following diagram uses the same tables and illustrates each of the physical display levels:
Display Options
You are also provided with display options for entities and their relationships. These options are useful for showing different types of information in the logical model:

- Entity display options
- Relationship display options

Use the shortcut menu to set these options.
**Entity or Table Display Options**

You can use the entity or table display options to view information about entities and tables in a data model.

![Entity or Table Display Options menu](image)

**Note:** The Format menu changes based on whether the currently displayed model is physical or logical.
Relationship Display Option

In both the logical and physical data model, you can use the display options to view the relationship properties.
Font and Color Change for Individual Objects

You can also change the color or font of individual objects in your diagram in the following ways:

- Select the object, then click an option in the Font and Color Toolbar
- Select the object, then right-click and select Object Font & Color on the shortcut menu.
**Customize Object Fonts and Colors**

When you add an object to a diagram, the default font, color, fill, and line options for that object type is automatically assigned. Use the Theme Editor to assign the default display theme to objects, or create your own theme. Use the following procedure to customize the settings for the objects you create.

**To customize object fonts and colors**

1. Click Themes on the View menu.
   
The Theme Editor opens.

2. Navigate the tabs on the dialog to set default color and font information. You can also specify font and color properties for all model objects, new objects you create, or current objects in the model.

   **Note:** The tabs that appear vary depending on whether you are working with a logical, physical, or logical/physical model.

   Click OK.

   The new default settings are saved and the dialog closes.
Changing the Diagram Window Magnification Level

You can use the following Zoom options, which are available on the erwin Data Modeler Toolbar and on the View Menu, to view a model at different magnification levels.

**Zoom Out**

Decreases the magnification of your model in the diagram window by an offset of 10.

**Zoom In**

Increases the magnification of your model in the diagram window by an offset of 10.

**Zoom Normal**

Resets the magnification level to 100 percent.

**Fit Model**

Reduces the magnification level to fit the entire model in the diagram window.

**Fit Selection**

Magnifies a specific area of the model to fit within the diagram window. Drag the magnifying glass cursor around the portion of the diagram window that you want to view and the appropriate Zoom level is applied to the model and fills the diagram window with the selected portion.

**Notes:**

- Display magnification is managed independently from print magnification. When you print the diagram window, the zoom display settings are ignored and allows you to change the scale to show more or less of the diagram window on each page.

- The minimum screen resolution supported is 1024 x 768. If your screen resolution is less than the minimum supported, some portions of the screen will not be visible. If you are working in an editor and you cannot see the Close or Cancel buttons, you can hit the Enter key to close and the Esc key to cancel.
Print a Data Model

You can print your model to your default printer. Before you print, you can customize options for the printed output.

To print a model

1. Click Print on the File menu.
   
The Print dialog opens.

2. Select from the following options on the Print dialog:

   **Printer**
   
   Specifies the destination printer. Select a printer name from the drop-down menu. Select Print to file to save the print output to a file instead of a printer.

   **Note:** The Microsoft Print to PDF option works well the first time you use the Print option. For every subsequent usage of Microsoft Print to PDF option, first set the Printer to another option and click Print. This causes the Microsoft Print to PDF drivers to reset. Thus, allowing you to print to a PDF file.

   **Print range**
   
   Print all pages of the model, or a range of pages.

   **Copies**
   
   Prints one or more copies of each selected page. You can also select to collate the copies.

   **Print what**
   
   Print the current diagram (the open diagram from which you opened the print dialog), or current selection or all diagrams currently open.

   **Print order**
   
   Specifies the direction taken for the print output. For example, if you have a large model that prints on multiple pages, you can select "Over, then down" to create a printout with a horizontal orientation. Or, select "Down, then over" to create a printout with a vertical orientation.
**Fit to page**

Specifies to scale the entire diagram so that it fits on a single page for the selected printer and paper size. Select the check box to enable this option.

*Note:* If you select this option and have selected more than one diagram to print, each diagram prints on a separate page.

3. Click Preview to view your output page by page, before starting the print job.

*Note:* The page preview that is displayed takes into account the page margins that you set in the Page Setup Editor. This means that what you see in the Preview page is what will be printed.

Click Zoom In to zoom the diagram to the size of the paper. Click Zoom Out to zoom the diagram to a size that can be fit in the Preview window.

To print immediately, click Print; otherwise click Close to go back to the diagram window.

4. Click Page Setup to customize print options such as page size, orientation, zoom, border, color, header, footer, and margin.
Print Only What You Want

You can use the mouse in the embedded Diagram Window in the Print dialog to perform the following tasks:

Change the print scale

Drag a page grid line until your model fits in the grid pages exactly how you want the model pages to print. You can also enter a value in the Print Scaling box.

Select specific pages for printing

Hold the CTRL key and click each page you want to print.
Set Printer Options

You can set your printer options before you print the model.

To set printer options

1. Select Print Setup from the File menu.
   The Print Setup dialog opens.
2. Accept the default printer, page orientation, paper size, and source settings or select another option:
   - Select a printer from the printer Name list to select a different printer.
   - Click Portrait or Landscape to select a different page orientation.
   - Select a different paper size from the Size list to change the paper size.
   - Select a different paper source from the Source list to change the paper source.
   - Click the Properties button to open the Windows Document Properties dialog to change graphic and print quality options.

Note: Changing to landscape page orientation affects both the page grid and the printer fonts. If you change the orientation for a model, you should adjust the objects and relationships in your model for the new layout.
Specify an Exact Print Scale Value

You can specify an exact print scale value in percentage.

To specify an exact print scale value

1. Select Print from the File menu.
   
   The Print dialog opens.

2. Enter the print scale value that you want to apply to the objects in the model in the Print Scaling (%) box, and click the TAB key.
   
   - Enter a value greater than 100 to enlarge the size of model objects.
   - Enter a value less than 100 to reduce the size of model objects.

   The size of the model immediately changes to reflect the print scale value that you specify.

3. Click the Print button.

   The model prints.

Note: To reset the model to 100% print scale, click the Reset Scale button.
Add a Page Header or Footer

You can add a customized header or footer (or both) to all the pages when you print a model. For example, you can print the Model Name, Subject Area Name, and Diagram Name at the top of every page, and the page number, date, and time at the bottom of every page.

**Note:** If you manually enter incremental information in the Header or Footer text box (for example, page number, date, and so on), you cannot automatically update the text.

A toolbar ![button1] ![button2] ![button3] ![button4] ![button5] is provided to make it easy for you to quickly add the following elements:

- Current Page
- Page Count
- File Name
- Subject Area Name
- Diagram Name
- Time
- Date

**To add a page header or footer**

1. Click Page Setup on the File menu.
   - The Page Setup Editor opens.
2. Click the Margins tab and work with the following options in the Header or Footer text box:
   - Click in the Header or Footer text box to specify in which area you want to insert the customized text.
   - Click the appropriate Header/Footer button to automatically insert information, or use the keyboard to insert other information (for example, your name).

A preview of your selection displays beneath the text box.
For example, if you selected file name and E/R diagram for the header, and date and time for the footer, then the preview would be as follows:

3. Work with the following related options in the editor:
   - Indicate page margins (in inches) for the header or footer.
   - Select the "Keep synchronized with Current Diagram" check box to associate your selections with the current diagram.
   - Click the Load from Diagram button to reset any changed settings to the settings last saved to the diagram.
   - Click the Save to Diagram button to save the current selections with the diagram for future use.

4. Click Close to save your settings, or Cancel to cancel your selections.
Page Margins

By default, the entire page is used for printing. Before you print, you can set separate page margins (top, bottom, left, and right) for the current stored display.

When you click the Page Setup button in the Print Model dialog, the Page Setup dialog opens at the Margins tab.
Page Boundaries

By adjusting the page grid boundary lines, you can control how much information prints on each page. The page grid boundary lines define the individual pages on which the model objects will print. Using your mouse, you can drag the page grid lines in the Print Model dialog (within the thumbnail view) or in the diagram window, so more or fewer objects are printed on a particular page. To adjust the page grids from the diagram window, you must first turn them on by choosing the Show Page Grid option from the Format menu. You can turn off the page grids in the same way.

When you adjust the page boundary lines, the size of the page grid also determines the print scale (the size of model objects and fonts). To enlarge the print scale, reduce the size of the grid. To reduce the print scale, enlarge the size of the grid.

Note: The paper size you select determines the dimensions of the page grid. To change the paper size, click Print Setup from the File menu and then select a different paper size option.

More information:
Specify an Exact Print Scale Value
Set Print Margins

You can specify margins for all pages of your printed model.

To set print margins

1. Click Page Setup in the Print dialog.
   The Page Setup dialog opens.
2. Click the Margins tab.
3. Enter a value between 0 and 1.5 inches for the left, right, top, and bottom of the page.
4. Click OK.
   The Page Setup dialog closes.

Note: Margin measurements are considered when displaying the embedded Diagram Window in the Print dialog.
Reporting

This section contains the following topics

Data Model Reporting
Data Model Reporting

erwin Data Modeler Navigator Edition supports reporting with ODBC connectivity using the Query Tool and Report Designer. You can also use the ODBC connectivity in erwin® Data Modeler to create reports using any tool that supports an ODBC connection, such as Microsoft Excel.
The Query Tool

The Query Tool provides an easy way to execute SQL SELECT queries against a model in erwin Data Modeler (DM), a model in a mart, or against a database catalog. You can execute a query against the objects and properties in the model, the metadata defining those objects and properties, and the action log that records the changes that are made to your model during the modeling session.

You can create new queries or paste text from another source (such as a *.sql file) into a query.

You can save a query to a *.qry file for later execution. Query results can be saved to a *.csv (comma-separated values) file.

Although the Query Tool provides a built-in query interface in erwin DM, you can also use any third-party reporting tool that has ODBC capability to query erwin DM modeling data.

For more information on using ODBC data sources and sample queries, refer to the How to Generate or View Reports and Useful Queries topics respectively.

More information:

Create a Query
Execute a Query
Execute a Query Against a Database
Execute a Query Against erwin ODBC
Save a Result Set to a CSV File
Create a Query

You can create a query (SELECT statement) by entering text directly in the Query box, or by pasting text from another source.

To create a query

1. On the ribbon, click the Tools tab.
2. Click Query Tool.
   The Query Tool opens.
3. Enter your query in the Query box, or click the paste button on the toolbar to paste a query from another source.
   Your query is ready for execution. Use other features in the Query Tool to execute and save the query.

Note: Before you can execute a query you must be connected to erwin ODBC or to a database. For sample queries and the details of schemas and tables, refer to the Useful Queries topic.

More information:

Execute a Query Against erwin ODBC
Execute a Query
Execute a Query Against a Database
Save a Query
Open a Query
You can work with queries you saved to a *.qry file in a previous session, or you can optionally use a *.sql, or Microsoft SQL Server Query file.

To open a query
1. On the ribbon, click the Tools tab.
2. Click Query Tool.
   The Query Tool opens.
3. Click the Open Query icon on the toolbar.
   The Open dialog opens.
4. Select a *.qry or *.sql file and click open.
   The query text opens the Query box and is ready for execution.

Note: Before you can execute a query you must be connected to erwin ODBC or to a database.

More information:
Execute a Query Against erwin ODBC
Execute a Query Against a Database
Restrict Row Count in Query Results
**Save a Query**

After you have created a new query or made changes to an existing query in the Query Tool, you can save your query to a *.qry file for future use.

**To save a query**

1. Click the **Save Query** icon on the toolbar in the Query Tool.
   
   The Save As dialog opens.

2. Select a file name and location for your query, then click Save.
   
   Your query is saved and the Save As dialog closes.

3. Click Close.
   
   The Query Tool closes.

**More information:**

The Query Tool

[Execute a Query](#)
Execute a Query

You can execute a new or saved query against the model or against a database catalog.

Use the following process to execute a query:

- Open the Query Tool from the Tools tab.
- Create a new query or open an existing query (*.qry) file.
- Connect to erwin ODBC or to a database.
- (Optional) Select the option to restrict row count and enter a number to indicate the number of rows by which to restrict results.
- Click the Execute icon on the toolbar.

After your query executes, the results display in the Results box. Use other features in the Query Tool to save the query or save your result set.

Note: For sample queries and the details of schemas and tables, refer to the Useful Queries topic.

More information:

The Query Tool

Save a Result Set to a CSV File
Restrict Row Count in Query Results
Execute a Query Against a Database

You can run your query against a database catalog. To do this, you connect to the database from the Query Tool and then execute your query.

Follow this process to run a query against a database:

- Open the Query Tool from the Tools tab.
- Create a new query or open an existing query (*.qry or *.sql) file.
- Click the Connect icon on the toolbar.
- Enter the database-specific connection criteria in the Connect dialog.
- (Optional) Select the Restrict row count to check box and enter a number to limit the number of rows returned.
- Click the Execute icon on the toolbar.

After your query executes, the results display in the Results box. Use other features in the Query Tool to save the query or save your result set.

**Note:** You cannot be connected to erwin ODBC and a database at the same time in the Query Tool. If you are connected to erwin ODBC, the (database) Connect icon is dimmed. Click the Disconnect icon on the toolbar to disconnect your erwin ODBC connection before you attempt to connect to a database. Also, before you can make a database connection, the appropriate database client software must be installed. See Database Connection Overview for more information.
Execute a Query Against erwin ODBC

To run a query against the current erwin Data Modeler model, you must first activate the ODBC connection. The connection may already be active, if you selected the option to start the ODBC driver on the Reporting tab in the Options dialog.

To connect to erwin ODBC

1. On the ribbon, click the **Tools** tab.
2. Click **Query Tool**.
   The Query Tool opens.
3. Open a query (*.qry or *.sql) file or create a query.
   Query text displays in the Query box and is ready for execution.
4. Click the **Connect to erwin ODBC** icon on the toolbar.
   The ODBC connection is established. The Disconnect icon becomes active. Use other features in the Query Tool to execute and save the query and result set.

More information:
The Query Tool
- [Execute a Query](#)
- [Change the Instance of an ODBC Connection](#)
Change the Instance of an ODBC Connection

If you have multiple copies of erwin Data Modeler (DM) running, the ODBC driver can only serve data from one instance. By default, this is the first one started. If you want to change which instance of erwin DM is handling the ODBC connection, you need to first stop the driver on the one that is running and then start the driver on the second copy of erwin DM from the same place.

To change the instance of an ODBC connection

1. Go to the copy of erwin DM that is running for which you want to stop the ODBC driver and click Options on the Tools tab.
   The Options dialog opens.
2. Go to the Reporting tab and click Stop ODBC driver for this instance.
   This button's display changes to Start ODBC driver for this instance once the ODBC driver is stopped for the current instance.
3. Click OK.
   The Options dialog closes.
4. Go to the other copy of erwin DM that is running for which you want to use the ODBC driver and click Options on the Tools tab.
   The Options dialog opens.
5. Go to the Reporting tab and click Start ODBC driver for this instance.
   This button's display changes to Stop ODBC driver for this instance once the ODBC driver is started for the current instance.
6. Click OK.
   The Options dialog closes and you are ready to start constructing a query.
Restrict Row Count in Query Results

When executing a query against a large model or database, you may want to restrict the row count for the query. This causes the Query Tool to process only the first $n$ number of rows indicated in the number field. This may be helpful if you have executed a query that returns lengthy results, but the section of the results that you would like to see is contained in the first 100 rows, for example. In this case, enter 100 in the *Restrict row count to* number field, and the query will only return the first 100 rows.

**To restrict row count in query results**

1. On the ribbon, click the **Tools** tab.
2. Click **Query Tool**.
   
   The Query Tool opens.
3. Select the **Restrict row count to** check box, and enter a number in the adjoining box.

   - **Restrict row count to:**

   When your query runs, the results that display are restricted to the first $n$ number of rows you indicate.

**More information:**

[Execute a Query](#)
Save a Result Set to a CSV File

After you have executed a query and the results display in the Results box, you can save the results to a *.csv (comma-separated values) file to work with it in other reporting tools, or to share with your modeling team.

To save a result set to a *.csv file

1. On the ribbon, click the Tools tab.
2. Click Query Tool.
   The Query Tool opens.
3. Open a query file or create a new query and click the Execute icon on the toolbar.
   Your query results display in the Results box.
4. Click the Save Result Set as CSV icon displayed next to the Restrict row count to box.
   The Save As dialog opens.
5. Enter a file name and location for your file and click Save.
   The file is saved, the Save As dialog closes, and you are returned to the Query Tool.

More information:
The Query Tool
Execute a Query
**The Report Designer**

Report Designer lets you create a wide variety of reports and on the current data available in your data models. If you are working in the Workgroup Edition, you can create Mart administrative reports and cross-model reports. You can create report templates for frequently used reports and you can export reports to HTML and CSV formats. You can create report solutions and include multiple report templates.

You cannot reuse the .RTB reports that were created using Report Template Builder, because the metamodel objects are changed. You must recreate the reports in Report Designer.

Several sample (pinned) reports are included with the application and they are available in the following location:

```
%Installdir%\erwin\Data Modeler r9\BackupFiles\Report Solutions
```

Also at the following location:

**Windows 7**

```
C:\Users\<user name>\AppData\Local\erwin\Data Modeler\er\9.8\Report Solutions
```

**Note:** The pinned reports are created using a Logical-Physical model. If you use the pinned reports with a Logical-only or a Physical-only model, it may result in inappropriate results.

**Follow these steps:**


2. To create a report solution, click Create new solution for reports on the toolbar.

   If the current report solution is not saved already, you are prompted to save it. A new blank workspace appears.

3. To create a report template, follow these steps:

   a. Click Create a Report on the toolbar. The Report Editor dialog appears.

   b. Enter a name for the report.
c. Select the model type that you want to report on. Select Mart to create a report on the Mart data.

The items in the Select Report Subject pane change according to the Report Type that you select.

**Note:** You must have the Reports: View permission to create Mart reports.

d. In the Select Report Subject pane, select the item on which you want to generate the report.

e. In the Select Report Fields pane, select the fields that you want to include in the report.

f. To create a report that filters specific objects and includes them in the report, use the Filter by option. This option is available only for entities, tables, attributes, columns, subject areas, and indexes.

g. Click Run Report.

If you are creating a report on your Mart and you have selected an option under Filter By, the Mart Report Filter dialog opens.

h. Select the specific models that you want to get the results from. Enter the specific model object name. Use wildcard characters, if necessary.

The report is generated and displayed. If you do not specify any model or entity, the generated report includes all the models. If you have used a wildcard, by default, the wildcard is applied to all the names. For example, if you type ID, the report includes Cust_ID and ID_For_Category. If the result is very large for Mart reports, the report is displayed in multiple pages (data grid). Use the navigational icons in the toolbar to view the subsequent pages.

i. (Optional) Click the Clear data in data grid icon to clear the results in the grid.

4. To configure report preferences, follow these steps:

a. Click Edit, Preferences. The Report Designer Preferences dialog appears.

b. Complete the following fields and click OK:

   **Add object type as prefix for the properties 'Name' and 'Physical Name'**
Prefixes the object type to only the Name and Physical Name columns. For example, you are generating a report on entities and the corresponding attribute names and data types. The column names in the report are displayed as Entity Name, Attribute Name, and Attribute Logical Data Type.

**Add object type as prefix for all other properties**

Prefixes the object type to all columns.

**Note:** These options work only when they are selected at the time of creating a report. If these options are selected at the time of modifying an existing report, they do not work.

**Apply optimization mode if row count is more than**

Specifies the number of rows at which the computer resources are optimized to display the report. If the row count in your report exceeds the number that you specify here, the report is displayed in optimization mode. In this mode, the group and sort options are not available in the result grid. If no value is entered, the row count for optimization mode is considered as equal to the total row count of a report.

**Number of top rows to display**

Specifies the number of top rows that you want to display. This option displays the first few rows that match a report criteria, when the result contains more rows than the number specified here.

5. To generate a report from an existing report template, select the template, right-click, and click Run.

6. To modify an existing report template, select the template, right-click and then click Properties. After you finish modifying, click Run Report.

**Note:** When you modify an existing report template and select more properties for the existing report subject, the selections are retained. If you select a different report subject, the previous report subject and its properties are not included in the report.
7. To customize the appearance of the report at the node-level, follow these steps:
   a. Right-click the node and click Properties. Complete the following fields:

   **Name**
   
   Specifies the name of the node. By default the name of the selected object is displayed.

   **HTML Style**
   
   Font Family: Specifies the font for the selected node.
   
   Size: Specifies the font size for the selected node.
   
   Roll up subtables: Specifies that you want to display a parent and its child node details together. This option is not effective when the report has only one node. The following image illustrates a report without selecting the Roll up subtables option:
The following image illustrates a report when the Roll up subtables option is selected:
### Entity/Table(s) of Model "EMOVIES r8"

<table>
<thead>
<tr>
<th>#</th>
<th>Entity Name</th>
<th>Attribute Name</th>
<th>Attribute Definition</th>
<th>Attribute/Columns FK</th>
<th>Attribute/Columns PK</th>
<th>Null Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td>EMPLOYEE</td>
<td>employee first name</td>
<td>Employee’s name</td>
<td>false</td>
<td>false</td>
<td>Null</td>
</tr>
<tr>
<td>.</td>
<td>EMPLOYEE</td>
<td>employee address</td>
<td>First line of the employee’s address</td>
<td>false</td>
<td>false</td>
<td>Null</td>
</tr>
<tr>
<td>.</td>
<td>EMPLOYEE</td>
<td>employee phone number</td>
<td>Employee’s home phone number</td>
<td>false</td>
<td>false</td>
<td>Null</td>
</tr>
<tr>
<td>.</td>
<td>EMPLOYEE</td>
<td>employee address 2</td>
<td>Second line of the employee’s address</td>
<td>false</td>
<td>false</td>
<td>Null</td>
</tr>
</tbody>
</table>

**Foreground:** Specifies the text color.

**Background:** Specifies the background color.

**Template Color:** Specifies that the color that is specified in the template is used.

**Bold/Italic/Underline/Strikeout:** Specifies the effect for the text.

**Width:** Specifies the width of the selected node (report column). You can specify the width for any node and it is applied when the report is exported to HTML.

**Alignment:** Specifies the alignment of the text.

8. To export a report solution to HTML, follow these steps:
   - Right-click the report solution and click Export All to HTML. The Report Export dialog appears.
   - Click Browse and select the folder to which you want to export the report.
- Go to the HTML tab and add the title in the Solution Title in HTML field.
- Click OK. The report is generated in the specified folder.

9. To export a report to HTML, follow these steps:
   
a. Click the Clear data in data grid icon and clear the result grid.
   This is a best practice and helps the application export the report without consuming much of the computer resources.
   
b. Right-click the report and click Export to HTML. The Report Export dialog appears.
   
c. Click Browse and select the folder to which you want to export the report.
   
d. Go to the HTML tab and complete the following fields:

   **Select the template for exporting to HTML**
   Specifies the templates that you want to use with the HTML report. You can use customized templates, provided the formatting is similar to the default templates. The default templates are available in the following folder:
   
   C:\Program Files\erwin\Data Modeler r9\Report\Template\Template-Default

   **Solution Title in HTML**
   Specifies the title for the entire report solution.

   **Report Header in HTML**
   Specifies the text that appears between the report title and the first line of the report.

   **Report Footer in HTML**
   Specifies the text that appears at the bottom of the report.

   e. Click OK. The report is generated in the specified folder. If the report data spans multiple page grids in the Report Designer, the data is segregated into multiple sections in the HTML. The sections are first divided by model name and then by
object name. This means that a section may include objects from different models, which are sorted by model name and object name.

10. To view the HTML report on a different computer, include the computer name in the path to the filename. For example, if you have published the report to c:\erwin\reports folder on a computer that is named Comp001, use the following path to access it:

\\comp001\erwin\reports\index.htm

**Note:** The computer from which you are accessing the report must be in the same domain as the one in which the report is published. In addition, the user who is accessing the report must have at least the read-only privileges on the corresponding folder.

11. To export a report or a report solution to CSV, follow these steps:

   a. Right-click the report and click Export to CSV. Or, right-click the report solution and click Export All to CSV. The Report Export dialog appears.

   b. Click Browse and select the folder to which you want to export the report.

   c. Go to the TEXT tab and select the following options:

   **Format**

   Specifies whether you want to include the first-level object names multiple times. For example, you have included entity names and attribute names in your report and you have selected No Duplicates. The entity name appears only once for all the corresponding attribute names. If you have selected Duplicates, the entity name appears as many times as the corresponding attribute names appear.

   **Text Qualifier**

   Specifies the symbol that you want to use to indicate the column headers.

   **Delimiters**

   Specifies how you want to separate two columns in the exported report. The option Comma Delimited creates a .CSV file and the remaining options create .TXT files.
d. Click OK. The report is generated in the specified folder.

12. To add a report from another report solution, follow these steps:
   - In the Report Designer dialog, right-click the template name and click Add Report.
   - Select the report that you want to include (.erpt file) and click OK.
   - Save the report solution.

**The Filter By Option**

Report Designer includes the *Filter By* option that lets you generate drill-down reports. Some of the drill-down reports that you can generate are as follows:

**Entity/Table level reports**
- Entities and tables in the current Subject Area
- Entities and tables that are selected in the current diagram

**Attribute/Column level reports**
- Migrated attributes and columns
- Owned attributes and columns
- Role-named attributes and columns
- Foreign (FK) Key groups and indexes
- Generated indexes
- Nonunique (IE) Key groups and indexes
- Primary (PK) Key groups and indexes
- Unique (AK) Key groups and indexes

**Subject Area reports:**
- All entities and tables in the current subject area
- Members of the current diagram
- Members of all the diagrams in the current Subject Area
- Members of all the diagrams in the Main Subject Area, that is, the members of all dia-
grams at the model level

- Members of the diagrams that are specified at run time

You can use the Graphical Member option for diagrams and can view the images of diagrams.

The filters for Entity/Table and Key Group/Index are available when you select the members of a diagram or a Subject Area.

Attributes and columns can be displayed the following order:

- Alphabetic
- Attribute (the order in which attributes appear on the logical model)
- Column (the order in which columns appear on the physical model)
- Physical (the order in which columns appear in the DDL after Forward Engineering)
- Reverse Alphabetic
**Report Designer Features**

Report Designer includes the following features:

**Count Objects**

Based on the Report Type selection on the Report Editor, it displays the count (number) of Subject Areas, Entities/Tables, Attributes/Columns, Key groups/Indexes, and Relationships that are present in the model. You can export this count to CSV format. On the Report Designer, click Export > Export Count to CSV.

**Report Explorer Features**

Move child nodes: To move the child nodes up or down within a parent node, right-click the node and click Move Up or Move Down. This option is to move child nodes within a parent node and not to move parent nodes in a report.

**Result Grid Features**

- **Drag-and-drop:** To change the order of columns, drag-and-drop the report node to the desired position in the Report Explorer pane. Select the report template and click Run current report on the toolbar.
- **Sort:** To sort the report results on a specific column, click the column header. The default sort order is the order in which you have created the objects in the model.
- **Hide a column:** To hide a column, click the column header and drag it away from the report until you see the cross mark. To display a hidden column, right-click a column header, click Columns, and then select the column that you want to display.

**Note:** Hidden columns are included when you export a report to CSV or HTML.

- **Group the report result by a column:** To group the report result by a column, click the column header and drag it to the Drag a column header here to group by that column section. The following illustration shows a report that is grouped by two columns:
Rename a column: To rename a column, right-click the corresponding node in the Report Explorer and click Properties. Enter a new name in the Node Name field and click OK. Select the report template and click Run current report on the toolbar.

Configure the look and feel of each column: To configure the look and feel of each column, right-click the corresponding node in the Report Explorer and click Properties. Complete the fields in the Customize report style section. Be aware that the styles applied to a parent node are not applied to child nodes automatically.

Clear grid: To clear the data displayed in the result grid, click View, Clear grid. Clearing the result grid is a best practice when exporting a large or a complex report to HTML.

Export to HTML and TXT: To export a report or a Report Solution, right-click it and click Export to HTML or Export to CSV. When you export a report to CSV, select the delimiter as Comma Delimited to view the report in CSV format.
Pinned Reports

You can open the built-in reports from the Open pinned reports from disk toolbar item. The pinned reports are available in the local computer of the user. The reports are segregated into categories and each category of reports is available in a separate folder. You can create a folder of your own add the reports of your choice to it.

Several sample (pinned) reports are included with the application and they are available in the following location:

%Installdir%\erwin\Data Modeler r9\BackupFiles\Report Solutions

Also at the following location:

Windows 7

C:\Users\<user name>\AppData\Local\erwin\Data Modeler\9.8\Report Solutions

Note: The pinned reports are created using a Logical-Physical model. If you use the pinned reports with a Logical-only or a Physical-only model, it may result in inappropriate results.

Reports that are copied directly under this folder do not appear in the Pinned Reports dialog. The reports must be in a subfolder under this folder.
**Mart Model Reporting Status**

When a Mart model is modified and saved using the Workgroup edition of erwin Data Modeler, although a confirmation message appears, erwin internal tables are still updated in the background. Further, when multiple users modify and save models simultaneously, models (internal tables) are queued for updating. If you generate a report on the model at this moment, the latest updates are not included. To provide you the correct reporting status of a model, the following enhancements are implemented:

- The Mart Open dialog is enhanced with a new column named Report Status. *Report Status* displays whether a model is ready for generating reports.
- The status bar of erwin Report Designer shows the number of models that are ready for generating reports. The status *Mart Report sync progress (X/Y)* indicates that of the Y models that are available in the Mart, X models are ready for reporting.

The Report Status column includes the following statuses:

**Updated**

Specifies that the model is ready for report generation. When a report is generated on a model with this status, it includes the latest updates.

**Updating**

Specifies that the model is still being updated. When a report is generated on a model with this status, it does not include the latest updates. Further, when a model is saved for the first time, the report may not include any information.

**Pending**

Specifies that the model is queued for update. When a report is generated on a model with this status, it does not include the latest updates. Further, when a model is saved for the first time, the report may not include any information.
Schedule Mart Report Synchronization

In the Workgroup Edition, the model data and model report data are stored in separate internal tables. The model report data table (m9ReportData) includes only those columns that are required to generate model-specific reports. When you update a model and save the changes, both the tables are updated. Although erwin Data Modeler displays a message that the model is saved, the corresponding model report data table is still being updated in the background. In this scenario, if you try to generate a report, the report may not include the details that you have just updated. This means, there is a delay in the synchronization of model data and the model report data tables.

From this release onward, you can synchronize the tables dynamically or schedule the synchronization for a later time. Typically such synchronizations are scheduled for a time when there is minimum traffic on the server. The default is dynamic synchronization.

Dynamic Synchronization

Specifies that the model report data table is updated as and when the corresponding model is updated. You can see the reporting status of the source models in the Report Status column of the Mart Open dialog.

Scheduled Synchronization

Specifies that the model report data table is updated at the scheduled time. You can see the reporting status of the source models in the Report Status column of the Mart Open dialog.

Follow these steps:

1. Log out of the Mart and stop the Mart Server service.
2. Navigate to the \webapps\MartServer\WEB-INF folder on the computer where erwin Mart Server is installed. Typically, the path for this folder is as follows:

   For a 32-bit version:
   <installation folder>\erwin\Mart Server r9\Tomcat\Webapps\Mart Server\WEB-INF

   For a 64-bit version:
<installation folder>\erwin\Mart Server r9\Tomcat64\Webapps\Mart Server\WEB-INF

3. Open the rest-context.xml file in a text editor such as Notepad and search for the following line:

   <property name="refreshReportData" value="true" />

4. Change the value to  false.

5. Navigate to the following line:

   <task:scheduled ref="reportTaskExecutor" method="run" cron="0 10 21 * * ?" />

6. Change the value for cron.

   Here, cron indicates the scheduled time. In this example, cron="0 10 21 * * ?" indicates that the models are synchronized for report generation at 9:10 pm every day.

7. Save the XML file.

8. Start the Mart Server service and log in to the Mart.

   Similarly, to change from scheduled to dynamic synchronization, change the value of <property name="refreshReportData" value="false" /> to  true.
Use Multiple Threads to Update Mart Models for Reporting

In the Workgroup Edition, the model data and model report data are stored in separate internal tables. The model report data table (m9ReportData) includes only those columns that are required to generate model-specific reports. When you update a model and save the changes, both the tables are updated. Although erwin Data Modeler displays a message that the model is saved, the corresponding model report data table is still being updated in the background. In this scenario, if you try to generate a report, the report may not include the details that you have just updated. This means, there is a delay in the synchronization of model data and the model report data tables.

This delay happens because, the update process is handled by a single thread in your computer. From this release onward, you can configure a Mart to use multiple threads to update a model. Using multiple threads increases the performance of the update process and improves the time taken for large models to be available for reporting.

Follow these steps:

1. Log out of the Mart and stop the Mart Server service.
2. Navigate to the \webapps\MartServer\WEB-INF folder on the computer where erwin Mart Server is installed. Typically, the path for this folder is as follows:
   For a 32-bit version:
   <install folder>\erwin\Mart Server r9\Tomcat\Webapps\MartServer\WEB-INF
   For a 64-bit version:
   <install folder>\erwin\Mart Server r9\Tomcat64\Webapps\MartServer\WEB-INF
3. Open the rest-context.xml file in a text editor such as Notepad and navigate to the following line:
   <property name="maxPoolSize" value="8" />
4. Change the value to a number of your choice.
The maximum number of threads that you can create depends on the system resources of your Mart server. If you enter a number, only the maximum number of threads that can be created per the system resources is created.

**Default:** 8

5. Save the XML file.

6. Start the Mart Server service and log in to the Mart.
Mart Report Data Compression

In the Workgroup Edition, the model data and model report data are stored in separate internal tables. The model report data table (m9ReportData) includes only those columns that are required to generate model-specific reports. When you update a model and save the changes, both the tables are updated. This approach is implemented to improve the performance of Mart report generation. From this release onward, you can improve the performance of Mart reporting further by changing the way the report information is stored in the report data table.

You can store the report information in two ways--binary or XML. By default, the report information is stored in binary format. Information is compressed in binary format, therefore it occupies less space. However, regardless of the format in which the information is stored, the accuracy of the information remains the same. When you change the storage format, the information for a model is converted to the new format the next time the model is saved. After you change the storage format, if you do not update a model, the storage format for that specific model is not changed. For example, suppose that you have 50 models in your Mart and the existing storage format is XML. The report data table has stored the information for all these models in XML format. Suppose that you change the format to binary and update 10 models today. The information for the 10 models is stored in binary format and the information for the remaining 40 models is in XML format.

Follow these steps:

1. Log out of the Mart and stop the Mart Server service.
2. Navigate to the \webapps\MartServer\WEB-INF folder on the computer where erwin Mart Server is installed. Typically, the path for this folder is as follows:

   For a 32-bit version:
   <installation folder>\erwin\Mart Server r9\Tomcat\Webapps\Mart Server\WEB-INF

   For a 64-bit version:
   <installation folder>\erwin\Mart Server r9\Tomcat64\Webapps\Mart Server\WEB-INF
3. Open the rest-context.xml file in a text editor such as Notepad and navigate to the following line:

   <property name="compressReportData" value="true" />

   **Default:** True (binary format)

4. To change the format to XML, change the value to **false**.

5. Save the XML file.

6. Start the Mart Server service and log in to the Mart.
Subject Area Reports

By design, a model is considered as the main Subject Area. Therefore, when you create a generic report on Subject Area and include its properties such as Name, the model is also displayed in the list of Subject Areas. However, the model name is not included when you generate a report on specific Subject Areas. You can generate a report on specific Subject Areas by selecting the Specify Diagrams at Run Time option.

The following diagram shows a generic report of Subject Area:

![Diagram showing a generic report of Subject Area]

In the previous report, <model> is the model and the remaining entries are Subject Areas.

**Note:** If you generate a Subject Area report for a Mart model, <model> is not included as a Subject Area. To generate a Subject Area report, we recommend that you open the Mart model and generate the report as a "local" model.
**Change the Logo on the HTML Report**

By default, erwin logo is displayed on HTML reports and the logo is linked to the erwin website. You can change the logo and link it to a website of your choice.

**Follow these steps:**

1. Open the folder where erwin Data Modeler is installed.
2. Navigate to the \Report\Template\Template-Default\_images folder.
3. Replace the image in the logo.png file.
4. Navigate to the \Report\Template\Template-Default folder.
5. Open the list.htm file in an HTML editor.
6. Replace http://www.erwin.com with the required URL, as shown in the following image:

   ![HTML Editor Screenshot]

   ```html
   </style>
   </head>
   <BODY BGColor=#{FFFFFF} TEXT=#{000000} link=#{0000FF} Vlink=#{000000} Alink=#{990000}>
   <p align="center">
   <a href="http://www.erwin.com" target="_NEWWINDOW">
     <img src="_images\logo.png" border="0" height="100px" width="100px"></a>
   </p>
   ```

7. Restart the application.

   The logo and the link to the website are changed when you generate a report the next time.
Generating TLX Reports

A TLX report is a model validation report that uses erwin Template Language (TLX). Report Designer includes some default validation reports and also lets you configure new reports with custom properties. You must be familiar with erwin Template Language (TLX) to configure new reports.

When you configure new reports, you can add two types of custom properties, filters and TLX properties. The code for a filter includes a function that returns TRUE or FALSE.

Generate a Default TLX Report

Report Designer includes default TLX reports at entity/table, attribute/column, domain, and relationship level. Some of the properties that are included in the default TLX reports are no definition or no primary key. This topic describes how you can create an entity/table level report as an example. You can create other TLX reports on the same lines as described in the procedure.

To create an entity/table level report, follow these steps:

1. Click Tools, Report Designer, Create a new report.
2. Select Logical/Physical for Report Type.
3. Click Entity/Table in the Select Report Subject pane.
4. In the Select Report Fields pane, expand Filter By and select the No Definition and No Comment check boxes.
5. Expand Properties and select Name, Physical Name check boxes.
6. Click Run Report.

The list of entities and tables that do not have a definition or a comment is displayed.

Create a Custom TLX Report

If you are familiar with TLX scripting, you can add your own functions for properties of your choice and configure custom reports. For example, you can create a report that gives the number of attributes in each entity. You can add two types of custom properties, filters and TLX properties. The code for a filter includes a function that returns TRUE or FALSE.

To configure a new report, you must modify the following configuration files:
These files are available in the <erwin install folder>\Report\TLX folder.

**Follow these steps to create a custom TLX report:**

1. Modify the TLXReportAssembly.xml file and include the TLX property that you want to report on.
2. Modify the TLXReportTemplate.FET file and include the function for the custom property.
3. Restart erwin Data Modeler.
4. Create a report in the Report Designer and select the TLX property that you have added.
5. Run the report.

Modify the TLXReportAssembly File

To display a property under the Filter By node or the Property node in the Report Designer, you must add an entry for the property in the TLXReportAssembly file.

The TLXReportAssembly.xml file includes the following parameters:

**Assembly ID**

Specifies the unique identifier for the property entry in the TLXReportAssembly file. You can enter any number of your choice, as long as it is unique within this file.

**OwnerID**

Specifies the owner ID for the object for which you want to create a custom property. Use the following owner IDs:

<table>
<thead>
<tr>
<th>Owner ID</th>
<th>Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>1075838979</td>
<td>Entity/Table</td>
</tr>
<tr>
<td>1075838981</td>
<td>Attribute/Column</td>
</tr>
<tr>
<td>1075838983</td>
<td>Domain</td>
</tr>
<tr>
<td>1075839016</td>
<td>Relationship</td>
</tr>
</tbody>
</table>
Name

Specifies the name of the custom property the way it appears in the Report Designer.

ExtractType

Specifies the type of report for which the custom property is available. 1 denotes Logical, 2 denotes Physical, and 3 denotes Logical/Physical.

DBMS Info

Specifies the database for which the custom property applies. Enter the information in the format, "database brand code, major version number of the database, minor version of the database."

A value of "0,0,0" indicates that the custom property applies to all databases. The following table provides the DBMS information for the databases that the current release supports:

<table>
<thead>
<tr>
<th>Database</th>
<th>DBMS Info in TLXAssembly</th>
</tr>
</thead>
<tbody>
<tr>
<td>Db2 for i 5.x/6.x/7.x</td>
<td>(1075859019,4,0)</td>
</tr>
<tr>
<td>Db2 for LUW 9.5</td>
<td>(1075858977,9,5)</td>
</tr>
<tr>
<td>Db2 for LUW 9.7/10.x</td>
<td>(1075858977,9,7)</td>
</tr>
<tr>
<td>Db2 for LUW 11.1</td>
<td>(1075858977,11,1)</td>
</tr>
<tr>
<td>Db2 for z/OS 8.1</td>
<td>(1075858978,8,1)</td>
</tr>
<tr>
<td>Db2 for z/OS 9.1/10/11</td>
<td>(1075858978,9,1)</td>
</tr>
<tr>
<td>Db2 for z/OS 12</td>
<td>(1075858978,12,0)</td>
</tr>
<tr>
<td>Hive 2.1.x</td>
<td>(1075859187,2,1)</td>
</tr>
<tr>
<td>Informix 10.x/11.x/12.x</td>
<td>(1075859006,9,2)</td>
</tr>
<tr>
<td>MySQL 5.x</td>
<td>(1075859129,5,0)</td>
</tr>
<tr>
<td>Netezza</td>
<td>(1075918978,7,2)</td>
</tr>
<tr>
<td>ODBC/Generic 2.x</td>
<td>(1075859009,2,0)</td>
</tr>
<tr>
<td>ODBC/Generic 3.x</td>
<td>(1075859009,3,0)</td>
</tr>
<tr>
<td>Oracle 11g/12c</td>
<td>(1075858979,11,0)</td>
</tr>
</tbody>
</table>
POSTGRESQL 9.6 (1075918977,9,6)
Progress 9.x/10.x/11.x (1075859010,9,0)
Redshift 1.0 (1075918979,1,0)
SAS (1075859013,1,0)
SAP ASE 15.x/16 (1075859017,12,5)
SAP IQ 15.x/16 (1075859130,15,0)
SQL Azure (1075859180,10,25)
SQL Server 2012 (1075859016,11,0)
SQL Server 2014 (1075859016,12,0)
SQL Server 2016/2017/2019 (1075859016,13,0)
Teradata 14.10 (1075859018,14,10)
Teradata 15.x/16.x (1075859018,15,0)

**TLXFunction**

Specifies the TLX function name for the custom property. The function name can be any name that describes the property.

**Is Filter**

Specifies whether the custom property is a filter or a property. Include a value of 1 for filter and 0 for property. If you include 1, the property is displayed under the Filter by node of the corresponding object. If you include 0, the property is displayed under the Properties node of the object in Report Designer.

**Follow these steps:**

1. Open the TLXReportAssembly.xml file in a text editor such as Notepad.
2. Add a line for the property that you want to include in the report.
3. Save the file.

**Modify the TLXReportTemplate.FET File**

The TLXReportTemplate.FET file includes the functions that help the Report Designer generate the report for a TLX property. You must modify the file to include the function for a custom property for which you want to generate a report.
Note: Use the same function name in the TLXReportAssembly and TLXReportTemplate files.

Follow these steps:

1. Open the TLXReportTemplate.FET file in a text editor such as Notepad.
2. Add the TLX script for the property that you want to include in the report.
3. Save the file.

Now the custom property appears in the Report Designer under the corresponding node. You can include the property in a report.

Example--Number of Attributes in an Entity

This example demonstrates how you can generate a report on the custom property Number of Attributes in an Entity. This property is of type TLX property.

Follow these steps:

1. Add an entry to the TLXReportAssembly.xml file to create a node for Number of Attributes in Report Designer.
2. Add the TLX function NumberOfAttributes to the TLXReportTemplate.FET file.
3. Create a report and include the Number of Attributes property.

Add an Entry to the TLXReportAssembly.xml File

Follow these steps:

1. Open the TLXReportAssembly.xml file from the <erwin install folder>\Report\TLX folder.
2. Add the following entry and save the file:

   <Assembly Id="1002" OwnerId="1075838979" Name="Number of Attributes" ExtractType="1" DBMSInfo="0, 0, 0" TLXFunction="NumberOfAttribute" IsFilter="0"/>

Add the TLX Function NumberOfAttributes to the TLXReportTemplate.FET File

Follow these steps:

Add the following code to the TLXReportTemplate.FET file and save the file:

SPIItemBegin = NumberOfAttribute
Set("Count", 0)
ForEachOwnee("Attribute")
{
    Increment("Count")
}
Value("Count")

Number of Attributes is added to Report Designer under Entity, Properties.

Create a Report and Include the Number of Attributes Property

**Follow these steps:**

2. Select the Report Type as Logical.
3. In the Select Report Subject pane, select Entity.
4. In the Select Report Fields pane, expand Entity, Properties, and select Name, Number of Attributes.
5. Click Run Report.
**Dimensional Modeling**

The ability to produce reports on data source mapping is added to Report Designer in erwin Data Modeler Release 9.5.2. In the data warehouse environment, it is important to track the following information:

- Source of the data.
- The method by which the source data is extracted and cleansed before it is imported into the data warehouse.
- The frequency and timing of data warehouse updates.

You may have a data warehouse that combines information from several online transaction processing (OLTP) systems and archived data into a single decision support system. Your data may also come from relational and non-relational sources. To support regular updates and data quality checks, you must know the source for each column in your data warehouse. You must also know when and how the data is updated. You can document all of this information using erwin Data Modeler. This information can also be produced as reports in various formats using Report Designer.
Report on Data Sources, Target Columns, and Transformations

This report includes the list of data sources, target columns, and the corresponding transformation details.

**Note:** To generate this report, you must have a model that documents data movement sources and has the column level mappings defined.

**Follow these steps:**

1. Open erwin Data Modeler and open a model in which data movement sources and column level mappings are defined.
2. Click Tools, Report Designer.
4. Enter the title of the report as ETL Mapping.
5. Enter a name for the report and select the Report Type as Logical/Physical.
6. Select the Report Subject as Entity/Table.
7. In the Select Report Fields pane, expand Entity, Properties, and select Name, Definition.
8. Expand Entity/Table, Properties, and select Comment, Dimensional Notation Role Type, and Physical Name.
9. Expand Attribute/Column, Properties, and select Comment, DS Comment, Name, Null Option, and Physical Data Type.
10. Expand Data Source Column/Data Movement Column, Properties, and select Name, Physical Data Type.
11. Expand Data Source Table/Data Movement Table, and select Name.
12. Expand Data Source Object, Properties, and select Name, Data Source System, Data Source Type.
13. Expand Attribute, Key Type and select Is PK, Is FK.
14. Click OK. The report template is added to erwin Report Designer.

15. In erwin Report Designer, right-click the template and click Export to TEXT. The report is generated and displayed.
16. Verify that the report contains data source mapping information for each target column.
<table>
<thead>
<tr>
<th>Subject Area</th>
<th>ER Diagram</th>
<th>Table</th>
<th>Comment</th>
<th>Column</th>
<th>Transform Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_date</td>
<td>day_number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_date</td>
<td>day_date</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_date</td>
<td>week_number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_date</td>
<td>month_number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_date</td>
<td>year_number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_geographic</td>
<td>geographic_area</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_geographic</td>
<td>geographic_area_name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_customer</td>
<td>account_number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_customer</td>
<td>customer_name</td>
<td>Full name of the customer</td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_customer</td>
<td>address</td>
<td>complete address should include postal code</td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_customer</td>
<td>customer_type</td>
<td>customer type</td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_customer</td>
<td>customer_type</td>
<td>customer type</td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_customer</td>
<td>customer_key</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_customer</td>
<td>customer_id</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_product</td>
<td>product_code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_product</td>
<td>product_name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_product</td>
<td>description</td>
<td>category name : category</td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_product</td>
<td>description</td>
<td>category name : category</td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_product</td>
<td>description</td>
<td>category name : category</td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>dim_product</td>
<td>other_details</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>fact_revenue</td>
<td>product_code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>fact_revenue</td>
<td>day_number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>fact_revenue</td>
<td>geographic_area</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>fact_revenue</td>
<td>fact_id</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;model&gt;</td>
<td>Fact and dimensions</td>
<td>fact_revenue</td>
<td>fact_name</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Report on Data Lineage with Diagrams

This report includes the data lineage (data source mapping) with diagrams.

Note: To generate this report, you must have a model that documents data movement sources and has the column level mappings defined.

Follow these steps:

1. Open erwin Data Modeler and open a model in which data movement sources and column level mappings are defined.
2. Click Tools, Report Designer.
4. Enter the title of the report as Browse ETL Mapping.
5. Enter a name for the report and select the Report Type as Logical/Physical.
6. Select the Report Subject as Entity/Table.
7. In the Select Report Fields pane, expand Entity, Properties, and select Name, Definition.
8. Expand Subject Area, Properties, and select Name.
9. Expand ER Diagram, Properties, and select Name.
10. Expand Members, Table/Entity, Properties, and select Table Physical Name.
11. Expand Attribute/Column, Properties, and select Comment, Physical Name, Null Option, Physical Data Type, DS Comment.
12. Expand Data Movement Column, Properties, and select Name, Physical Data Type.
13. Expand Data Source Table/Data Movement Table, and select Name.
14. Expand Data Source Object, Properties, and select Name, Data Source System, Data Source Type.
15. Expand Attribute, Key Type and select Is PK, Is FK.
16. Click OK. The report template is added to erwin Report Designer.

17. In erwin Report Designer, right-click the template and click Export to HTML.
   The report is generated and displayed.
18. Open the HTML report and verify the data mappings. Verify that the report contains diagrams and clickable entities through which you can navigate to the data source mapping information.

Click here to view a video demonstration of this report.
Product Differences

This section contains the following topics:

- erwin Data Modeler Navigator Edition Differences
- Data Model Disabled Menu Items and Toolbar Icons
erwin Data Modeler Navigator Edition Differences

You can use this product to view, manipulate, print, and report on models on a local drive, network, or on a mart database.

The toolbar, menu and dialog options that are unusable in the components of this product are either absent or grayed out to show that they are disabled. For experienced users who are already familiar with erwin Data Modeler, the options that are not available in this product are specified in the following sections.
Data Model Disabled Menu Items and Toolbar Icons

The following menu items and their corresponding toolbar icons are unavailable when you are working with data models using erwin Data Modeler Navigator Edition:

**File**
- Save
- Save As
- Mart, Save
- Mart, Save As
- Mart, Lock
- Mart, Version Manager
- Mart, Library Manager
- Mart, Session Manager
- Mart, Security Manager
- Export to External Format

**Actions**
- Database Connection
- Reverse Engineer
- Forward Engineer (all rollover menu items)
- Design Layers (all rollover menu items)

**Tools**
- Standards (all rollover menu items)
- Add-Ins (all rollover menu items)
- Options

**Report Designer**